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Voxon Unity Plugin User Guide 
 

Unity is a popular 3D engine for developing applications. The Voxon Unity Plugin (VxU) 

makes it possible for Unity applications to run as VX applications. A Unity VX App can take 

advantage of Unity’s impressive 3D engine, assets store and its plentiful online tutorials.  

To get started developing VX apps with Unity, you will need to download both Unity and the 

Voxon Developers Kit.  

 

Note: The Voxon Unity Plugin is not located on the Unity Asset Store. It is an asset 

package included in the Voxon Developers Kit which is obtainable from our website 

(www.voxon.co), or download directly from https://github.com/Voxon-

Photonics/Content-Developers-Kit 

 

What build of Unity to use? 
 

There are many versions of Unity. It is easiest to manage if you install Unity Hub which lets 

you install multiple build versions of Unity on a single computer.  

It is recommended that you use Unity version 2021 LTS (Long Term Support) with the 

Voxon Unity Plugin.  

Note: When developing any software with Unity, avoid changing Unity builds mid project as 

switching Unity versions can result in compatibility problems, and potentially breaking your 

project! 

http://www.voxon.co/
https://www.google.com/url?q=https://github.com/Voxon-Photonics/Content-Developers-Kit&sa=D&source=hangouts&ust=1627353371798000&usg=AFQjCNGMGG7VFIZqpz51G_YtNejaLxkNwA
https://www.google.com/url?q=https://github.com/Voxon-Photonics/Content-Developers-Kit&sa=D&source=hangouts&ust=1627353371798000&usg=AFQjCNGMGG7VFIZqpz51G_YtNejaLxkNwA
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Note: it is recommended that you develop your VX Unity Apps on a Windows Machine  

 

What Voxon Runtime and files are needed? 
 

The Voxon Unity Plugin uses a C# bridge to interact with the voxiebox.dll. For this interaction 

to work, a few files and system settings need to be in place: 

● C#-Bridge-Interface.dll and C#-Runtime.dll files need to exist in the Voxon Runtime 

directory (by default located at C:\Voxon\System\Runtime). 

● User Path Variable needs to have the Voxon Runtime added. 

● The Voxon Runtime path needs to be added to the system registry.   

 

When you download the Voxon Developers Kit, the files, path variable, and registry values 

are created but you can reset the path and registry values by looking at the files within the 

‘C:\Voxon\System\Setup’ 

 

 

Links to Unity Video Tutorials 
 

As an alternative to reading this documentation, we have created a few video tutorials on 

using the Voxon Unity Plugin.  

 

 

Video 1, Introduction:  https://www.youtube.com/watch?v=ztMUCE0STss 

Video 2, Scene creation:  https://www.youtube.com/watch?v=BzZkC2DKo3k 

Video 3, Advanced Unity:  https://www.youtube.com/watch?v=C7fbXV_RQ0E 

 

How to add the Voxon Plugin to a Unity Project 
 

As the Voxon Unity Plugin is released as a Unity Asset Package (not available on the Unity 

Store), you will need to add this asset to your Unity Project. For an existing project you can 

import the Voxon Unity Plugin by the top menu and navigating to Assets>Import 

Package>Custom Package. 

 

1) Import the Voxon Asset Package 
 

https://www.youtube.com/watch?v=ztMUCE0STss
https://www.youtube.com/watch?v=BzZkC2DKo3k
https://www.youtube.com/watch?v=C7fbXV_RQ0E
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Figure 1 Use the Asset drop down menu to import the Voxon Unity Plugin into your project. 

 

 

Click on the ‘Assets’ menu, then select ‘Import Package’ and then ‘Custom Package…’. 

 

2) Navigate to the Voxon Asset Package 
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Figure 2 Navigating to where the Voxon Unity Plugin is located (VoxonPhotonics230731.unitypackage was the 
latest asset package name of writing this document)    

 

The Voxon Unity Plugin is located within the Voxon Developers Kit (‘…\Voxon\Developers 

Kit\Voxon Plugins\Unity’). 

 

3) Import all the package files. 

 

 
Figure 3 Make sure all the contents of the package are ticked and then click ‘Import’ 

 

By default, make sure all the files are ticked to be imported and import them into your 

project. When you are more familiar with using the plugin, you can import only the files you 

need.  

4) Ensure the plugin is installed 
 

The plugin should now be added to your project. 

If you are getting the following “cannot be used because it is not part of the C# 4.0 language 

specification” error(s) in the debug window, it means the project’s Scripting Runtime is out of 

date. 

 

Assets/Scenes/Voxon.Examples/2_ComplexMesh/Scripts/CharacterSpawne

r.cs(30,37): error CS1644: Feature ‘interpolated strings’ cannot 

be used because it is not part of the C# 4.0 language 

specification. 
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Figure 4 Error message from Unity when the Project’s Scripting Runtime is out of date. 

 

 

To fix this within Unity, make sure that your project’s ‘Scripting Runtime Version’ is at least 

‘.NET 4.x Equivalent’. You can find this setting by navigating: 

Edit->Project Settings->Player->Other Settings->Configuration->Scripting Runtime Version.  

 
Figure 5 The Project’s Player settings within Unity   

 

If the plugin has been initialised successfully, you will notice some new directories in your 

project and a ‘Voxon’ menu option in the top menu bar.  

 

Figure 6 The new directories and files added to your project from the plugin. 
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5) Add the _camera prefab to your current scene. 
 

To render anything on the VX1, you will need to set a Voxon camera. Included in the plugin 

is a ‘_camera’ prefab. This prefab captures anything within it and sends that data to a VX1. 

Look under the Voxon prefab folder within your assets folder and drag the ‘_camera’ prefab 

into your scene. 

  

 

Figure 7 Drag the _camera prefab into your scene to add a Voxon camera.   

 

6) Setup the Process Manager 
 

Set the ‘_camera’ object to be the ‘Editor Camera’ in the ‘Process Manager’. Click on the 

Voxon menu tab and select ‘Process’.  Drag the ‘_camera’ object to the ‘Editor Camera’ field. 

 

Figure 8 To activate a camera open the Process Manager and drag the _camera GameObject to the ‘Editor 
Camera’ field. 
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7) Run your Project  
 

That should be all that is needed. Save your project, then press the ‘Run’ button.  

 
Figure 9 Test your program. 

 

the project should run and render on a new instance of Voxon simulator window.  

 

Note: Always save your project before testing as Unity /  VxU plugin can crash 

often. 

Always Press the ‘Esc’ key to exit the simulator once you have finished testing. Do 

not press the ‘Play’ triangle button on Unity to end the test. Do not use the 

VoxieMenu ‘File > Shutdown’. Always use the ‘Esc’ key otherwise the system can 

become unstable. 

This is a problem we are aware of and are working on a solution, but it 

demands a total reworking of the Voxon Unity Plugin. Not an easy fix! 

 

Tip: when using the Voxon Unity Plugin it is recommended you turn off ‘exclusive mouse’ on 

the Voxon Simulator. This setting is under the ‘Misc.’ Tab. 
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Figure 10 Turn off Exclusive Mouse to reveal your cursor when developing with the Voxon Simulator    

 

Press (File > Save Settings) to keep this setting for future testing. This will make it easier to 

use the mouse as you develop your application.  

 

Voxon Example Scenes 

 
A variety of example scenes can be found under ‘Scenes > Voxon.Examples’ in the project 

files. New examples are added often, and these are a great place to learn how to use the 

plugin.  

 
Figure 11 The ‘Voxon Example’ folders provide many examples of using the Voxon Unity Plugin 

 

The ‘Voxon’ File Menu 

 
The Voxon File Menu holds various items to do with the Voxon Unity Plugin. 
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Figure 12 Introducing the ‘Voxon’ file menu. 
 

Here is a general breakdown of all the options: 

Tools -> Reimport Textures: Once the plugin is initialised all textures added to the project 

are also added to an internal list managed by the Voxon Unity Plugin. There are some 

instances where the textures do not get added. This can happen if there were textures 

added to the project before the plugin was imported or sometimes an error occurs. Pressing 

the ‘Reimport Textures’ button will reimport all textures in the entire Unity Project. Run this 

tool if textures are missing from the volumetric render or you receive texture related 

errors in the Unity Debug menu.  

Tools -> Reimport Meshes: Like the ‘Reimport Texture’ tool. All meshes added to the 

project after the plugin is set up will be amended to an internal list. Run the Reimport 

Meshes tool if the internal list is missing meshes or has become corrupt. Meshes 

added before the plugin was initialised will not be added until this tool has been run. 

Tool -> Rebuild Mesh: Reduces scene loading times by creating a cache of all the mesh 

data in the scene. If no mesh cache is created Unity must prepare all the mesh data for the 

Voxon Runtime every time the scene is loaded or tested. By selecting ‘Rebuild Mesh’ a 

cache of all the mesh is created. 

 

Tool -> Prebuild Textures: Reduces scene loading times by creating a cache of all the 

texture data in the scene. If no texture cache is created Unity must prepare all the texture 

data for the Voxon Runtime every time the scene is loaded or tested. By selecting ‘Prebuild 

Textures’ a cache of all the textures is created. 
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Managing Inputs using The Voxon Input Manager   

 
 Figure 13 The Voxon Input Manager for adding your own inputs.   

 

Standard Unity inputs don’t work for a VX app, so the Input Manager was created as a way 

of passing through input states from Unity to the VX app.  

The Input Manager is used to set various inputs (keyboard, mouse, Space Navigator and 

USB game controllers) to be used while the VX app is running. All input buttons need to be 

defined in the Input Manager.  

To reference these keys within scripts, use the ‘Voxon.Input.GetKey()’ function or relevant 

functions depending on the input type. For more information see examples scenes.  
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Setting The Voxon Process Manager 

 
Figure 14 The Voxon Unity Plugin Process Manager  

 
There are many settings in the Process Manager to do with rendering the volumetric display. 

Script: The script that is used to manage the rendering process. ‘VXProcess’ is the default, 

but it is possible to write your own custom script.  

Kill VX Runtime: Kills the current Voxon Runtime if it is left running. 

Debug Vx Process: If Visual Studio’s debugger is attached to Unity hitting this button will 

force a breakpoint in the default VXProcess script.  

Guidelines: Toggles on / off a border around the outside of the volume.  

 

Show_vps: displays the VPS information onto the secondary (touch) screen.  

Show_version: displays the Unity Plugin and voxiebox.dll version onto the secondary 

(touch) screen.  
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Active: if ticked, when you test your app it will launch the Voxon Simulator. Disable this 

setting if you want to do debugging without loading the simulator (good for quick 

changes and safer with a lower risk of crashing!). 

Apply_vx_on_load: if enabled all GameObjects that do not have a ‘VxGameObject’ script 

attached will have one attached when the app is started. Any GameObject without a 

‘VXGameObject’ (or ‘VXComponent’) script attached will not render on the volumetric 

display. 

Editor Camera: Is to be referenced to the GameObject that is the ‘camera’ for the VX app. 

Use the ‘_camera’ prefab as a starting point. Anything within the bounds of the camera 

GameObject will be displayed.  

Fixed Frame Rate: enable this to force the volume to be updated at a fixed rate. A VX1 runs 

at 15 frames per second.  

Target Frame Rate: set a target frame rate to operate at when a fixed frame rate is enabled.   

Recording Path: If using the Voxon x Unity plugin to capture / record a VCB (Volumetric 

Compressed Bitmap) video where to output those files. 

Record On Load: If enabled when the scene starts it will be automatically recorded. 

Recording Style: Toggle between recording an ANIMATION (a chronological series of 

frames) or a SINGLE_FRAME, one instance.  

Logger_max_lines: the number of lines the internal Voxon logger can output. The text is 

displayed during a VX app runtime on the secondary (touch) screen. The default is set to 10.   

Version: shows the current version of the Voxon Unity Plugin. 

 
Figure 15 The Version information for the Voxon Unity Plugin 
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The _camera prefab 
 

The camera prefab is a special GameObject that represents the Voxon display volume. The 

dimensions (10 x 4.44 x 10) adheres to the default aspect ratio of the volumetric display (1 

x.4 x 1). It also uses the special Unity Tag ‘VoxieHide’ which prevents the object from being 

rendered on the volumetric display. The ‘_camera’ prefab is located under the Voxon > 

prefab folder. 

Technically any GameObject can act as a camera, just remember that the dimensions of the 

camera are derived from the scale of the GameObject and make sure that the GameObject 

has the ‘VoxieHide’ Tag. 

 
Figure 16 The 'VoxieHide' tag and Scale of a GameObject is what makes it work as a Voxon camera object. 

 

Not rendering a GameObject on the Volume – The ‘VoxieHide’ Tag 

 
Special tags are used to interact with the Voxon Unity plugin. In Unity a single tag can be 

applied to any GameObject. The option is located just beneath the name of the GameObject. 

‘VoxeHide’ is a special Voxon specific tag that is used to prevent GameObjects from being 

rendered on the volumetric display. It’s the tag that makes a Voxon Camera work, but it can 

be used for other purposes. 

If your Unity Project does not have the ‘VoxieHide’ tag you can add it in to as a custom tag. 

 
Figure 17 You may need to add VoxieHide to your project's custom tags 

 

Special VX Scripts 
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Figure 18 A list of the special ‘VX scripts’ to be used with Unity. 

 

Included with the Voxon Unity Plugin there are a bunch of scripts starting with ‘VX’ these ‘VX 

scripts’ are used to help the Voxon Unity Plugin and developers work.  

 

Summary of the included ‘VX’ scripts 
 

VX Component  
 

Needs to be attached to every GameObject that you want to render on the volumetric 

display. It also has a few different rendering methods and an auto expire mode.  

 
Figure 19 The VX Component Script element 

 

Mesh Path: Automatically generated field when the object has mesh.  

Flags:   Instructs how the GameObject should be rendered:  

DOTS:  Draws only a voxel at every vertex. 

LINE:   Draws the wireframe of the vertices. 
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SURFACES:  (default) Draws the mesh’s surfaces, default and recommended for 
most instances. 

SOLID:  Fills the surfaces with solids (warning this method draws many voxels 

and requires a lot of CPU power) 

Can Expire:  If enabled, hides the GameObject after a desired amount of time based on 

the ‘Time To Live’ field.  

Time To Live:  The time in seconds before the GameObject is not rendered on the volumetric 

display.  

 

VX Game Object 
 

Any GameObject with the VX Game Object script added to it will render onto the volumetric 

display. A VX GameObject script will also attach a VX Component script to any sub 

GameObjects associated with the parent GameObject. This is useful when working with 

hierarchies.  

 

VX Heightmap, VX Polygon, VX Sphere, VX Heightmap  
 

Scripts which have not been fully developed and are reserved.  

 

VX Text Component 
 

Can be used to render text onto the volumetric display using the font used from the 

voxiebox.dll. This text can be rotated and scaled at any angle and relies on three vectors. 

 

Pr – The right vector. The X value of this determines the width of the text.  

Pd – The down vector. The Y value of this vector determines the height of the text. 

PP – The left top position.   This value determines the position of the text. 

 

Color:  The HEX value of the RGB colour to be displayed. This value 

is intended to be a hex number so it is a 16 base number 

presented as a 10-base number the default is ‘16777215’ 

which is 0xFFFFFF in hex so it would be white. Red would be 

16,711,680 (0xFF0000) etc…  

Text:      The actual text to display.  

 

Force Update Per Frame: Enable this feature to have the text object update per Unity 

frame.  
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See the 5_Text_Display example scene to see this script working in a demo.  

 

For a more robust and easier to use Voxie text Script we recommend using ‘VoxieText.cs’ 

VX Process 
 

This is a special script which the Voxon Process Manager uses to execute its renderer. It is 

a singleton (can only be instantiated once) and not to be attached to various GameObjects. 

Must only be used for the Process Manager. 

Note: If you have Apply_vx_on_load enabled on the Voxon Process Manager any 

GameObjects in your scene that do not already have a VX Game Object or VX Component 

script attached will automatically get a script attached on launch. 

 

Performance Monitoring 
 

The VX1 operates at 15 volumes per second. ‘volumes per second’ is the volumetric / 3D 

equivalent of ‘frames per second’ used in traditional computing. 15 volumes per second is 

the 2D screen equivalent of 15 fps. It is how many times the CPU is drawing the screen / 

volume per second.  

 
Figure 20 The VPS counter displayed by Show_vps 

 

It is important that your VX app runs at least 15 volumes per second (above 30+ VPS is 

recommended). 

The VPS amounts to how many volumes the VX1 can render, and it is dependent on your 

computer's CPU load. Ultimately VPS is related to the amount of work your VX application is 

asking the CPU to do.  

While using the simulator you can check the current VPS at any time. If you have 

‘Show_vps’ checked in the Voxon Process Manager, it will display on the secondary screen. 

You can also see the VPS by turning on ‘show stats’ under the ‘Misc’ tab. 

Keeping your app performant is important and while you are developing here are some tips 

to keep your VPS counter high:  

● In general, the more voxels (3d pixels) you are rendering the more the CPU is 

working. 

● The resolution on the VX1 is quite low compared to a traditional 2D screen. The 

volumetric display is about the equivalent 1000 x 1000 x 200 pixels. So often texture 
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and the number of vertices in a model are too high resolution to be noticeable on the 

volume.  

● Reduce a mesh’s vertices amount - every mesh that is being rendered onto the 

volumetric display is made up of vertices.  Your models may not have to be as high 

poly count. 

● Reduce texture size. Every texture being rendered needs to be interpreted by the 

voxel frame buffer. A smaller texture size speeds up this process.  

● Test often and optimise your project as you work. Always be aware of your VPS 

count. 

● Sometimes it is not the rendering of the volumetric graphics that is slowing an app 

down. Check to see if there are any other processes happening within your app that 

are causing performance issues. 

● Try to display what is needed. Less is more with the VX1. 

● Unity has its own profiler which may help with obtaining more performance.     

 

 

Building Your Project to Use On a VX1 
 

Building your project to run as a VX app on real VX hardware is as straightforward as 

building any Unity application.  

 

1) Check the build settings. 
 

Click on the File menu and select ‘Build Settings…’ 

 
Figure 21 To build your app into an executable choose ‘Build Settings..’. 
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2) Add the scene (or scenes) to be built into an app. 

 
Figure 22 Building your app check that the Scene(s) you want to build are ticked, the 

Platform is for Windows and its Architecture is 64 bit. 

 

Make sure the scenes you wish to build are included in the ‘Scenes In Build’. You can build 

multiple scenes into a single app. The scene at the top of the list is the scene which your app 

will launch in.  

Make sure the platform is set to ‘PC, Mac & Linux Standalone’. Target platform is ‘Windows’ 

and Architecture is ‘x86_64’. 

Once you have these settings set click ‘Build’ to build your VX app! 

 

Note: Make sure you have your Editor Camera active and The Voxon Process Manager is 

set to be ‘active’ set otherwise your VX app won’t display anything.  

3) Choose a folder for the location of your build. 
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Figure 23 Choosing a destination to build your VX Unity app. 

 

Choose a folder to build your app. You can call it whatever you like.   
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4) Test your app 

 

 

Figure 24 If your app has been built correctly you will have a VX.bat file to launch your app. 
 

Navigate to the folder you built your app in. If the build was successful, you should see a 

bunch of files; The executable for your project, the VX.bat file (the ideal method to launch 

your project), Unity Crash Handler, Unity’s DLLs, Local DLL instances of the C# bridge and 

C# interface (we include these to make your app more compatible these can be deleted and 

will fall back to whatever ones are in your Voxon Runtime folder)  

 

In this example UnityVoxonPackage.exe is the program’s main executable (which will be 

named after whatever you called it). You can run this, and it will work just fine, but for an 

optimised experience you will want to run the VX.bat file.  

 

The VX.bat runs the VX application in ‘batch mode’ (runs the Unity.exe with a -batchmode 

parameter), ‘batchmode’ runs the application without creating a Unity window to render the 

graphics. (it’s OK because the Voxon Unity Plugin knows what to do and works directly with 

the Voxon Runtime). 

 

VXUnityApp.exe a -batchmode 

 

Note: Running a VX Unity app using the standard executable will still work but you will 

notice that there is a Voxon window created and a standard Unity window. This takes more 

CPU power as the computer must manage 2 instances of your program running. This is not 

ideal or practical. 

 

To launch double click on the VX.bat file. 
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Figure 25 A VX Unity app being run on the Voxon Simulator 

 

If your build settings were correct your app should run. Your app will work on any other 

system that has the Voxon Runtime installed. 

Note: If your VX app doesn’t load, check that you actually added the scene to the ‘Scenes In 

Build’ selection bin in the build settings option and that your scenes have a valid ‘_camera’ 

object attached.  
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Model Viewer Unity Example 
 

 
Figure 26: Image of a Unity VX application running (Between Worlds) 

 

Within the Developers Kit is a binary and package example of a VX Unity App called ‘Model 

Viewer’ this project loads and animates FBX models (or any prefab model that has the 

custom Unity Tag ‘Model’). Various inputs controllers such as keyboard, mouse, gamepads 

and the SpaceMouse can be used to transform the models. It is a good example for the VxU 

Plugin.  

It is located at ‘...\Voxon\Developers Kit\Voxon Plugins\Unity\ModelViewer Example’. 

 

 

The VxProcess.cs Script 
 

The VxProcess.cs script is the entry point for the VxU plugin. It is the ‘engine’ that drives the 

plugin. Managing the C# Runtime, transforming the mesh, handling user input and managing 

the _camera instance.   

As you get familiar with the VxU plugin and The Voxon Runtime you’ll be able to write your 

own VxProcess or modify the default one to suit your needs. 

Like many Unity scripts it adheres to the two main functions. Start() and Update() it also 

includes a Draw() function where it draws all the IDrawables and VXGameObjects from its 

internal list 

The VXProcess contains the behaviour for both while using the Unity Editor and when 

running a build Unity Application (this is determined by precompiler statements  “#if 
(UNITY_EDITOR) { … }” )   



Voxon x Unity Plugin User Guide 

Matthew Vecchio  

Voxon Photonics 

 

 

24 
 

 

Summary of VXProcess.cs script’s components and key functions 
 

Runtime – A local instance of the Runtime.cs class to interact directly with the C#-

Runtime.dll 

VXCamera – A reference to a valid Voxon _camera object class. A Voxon camera manages 

the virtual volume which is to be sent to the volumetric display.  

IDrawables List – stores all references to classes which are inherited from the IDrawables 

class and are to be iterated upon and rendered. 

VXGameObjects List - stores all references to VXGameObject instances to be iterated 

upon and rendered. 

 

Start() Function - checks it has a valid Runtime class and VXCamera GameObject, starts 

the timers and initialisers and starts a new Voxon Runtime Instance.   

Update() Function - Updates timers, checks the Voxon Runtime’s Breathloop state, starts a 

volumetric frame (Runtime.FrameStart()) calls its internal draw() function, ends the Voxon 

frame (Runtime.FrameEnd()). Checks for user and system input if the Unity Application has 

been closed.   

Draw() Function - Iterate through all the drawable lists (any classes that inherits the 

IDrawables interface or is a VXGameObject that has been added to the list) and execute 

their .Draw() function. Translates all the meshes from Unity’s coordinates to Voxon’s space – 

see Appendix B.  

 

How To Draw Directly to the Voxon Display 
 

If you are an experienced Vx App developer, you may wish to interact with the volume 

directly. 

To draw Voxon primitives (such as simple text and primitive shapes such cubes, spheres, 

cones, lines and dots) from a custom C# Script you’ll need to inherit the IDrawable class 

from the Voxon namespace and then add it to the VXProcess.cs internal IDrawable 

reference list. 

The VxProcess manages a list of references of IDrawable inherited classes. When it comes 

to rendering a scene, this list is iterated through and each’s draw() function is called. 

Interestingly All VXGameObjects references are also maintained in a separate list within the 

VxProcess. These two lists maintain most (all in most cases) of the Unity Game Objects that 

are to be rendered on the Voxon Display.  
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Figure 27: Code snippet of the VXProcess.cs script where both the drawable lists are 
initialised.  

 

 

1) Use the Voxon namespace 

To access the VXProcess and Voxon variable types in your own scripts add the Voxon 

namespace.  

using Voxon; 

 

2) Inherit from the IDrawable class :  

public class <<YOUR CLASS>> : MonoBehaviour, IDrawable 

 

3) In the Setup function of your script add the instance of the class to the IDrawables list 

  VXProcess.Drawables.Add(this) 

 

4) Create a Draw() function which will be called by the VXProcess on every update.  

 

public void Draw() { } 

 

5) Within the Draw() function 

Use the VxProcess.Runtime.draw () functions to use various Voxon Draw calls…  

Such as : 

VxProccess.Runtime.DrawBox() 

VxProccess.Runtime.DrawCube() 

VxProccess.Runtime.DrawLine() 

VxProccess.Runtime.DrawSphere() 

 

Infact the VxProccess.Runtime gives you access directly to the C# bridge so you can 

interact with the Voxon Runtime in many ways beyond just drawing graphics!  
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Figure : Using Intellisense to demonstrate the various runtime Voxon calls. 

 

 

DrawSphere.cs Example script   
 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

using Voxon; // use the Voxon namespace to reference the VX process 

 

/* Example Script of drawing directly to the Voxon display.  

 * this script when added to a Unity scene it will render a white 

sphere in the centre of the volume 

 * by Matthew Vecchio for Voxon. 

 */  

 

public class DrawSphere : MonoBehaviour, IDrawable    // make sure 

you 

 //inherit the IDrawable interface so your class can be added to the 

IDrawable list.  

{ 

    void Start() 

    { 

        VXProcess.Drawables.Add(this); // add this script to the 

internal VXProcess Drawable list 

    } 

 

    public void Draw() 

    { 

        point3d pos; 

        pos.x = 0; 

        pos.y = 0; 

        pos.z = 0; 

        // position, radius, 0 = not filled : 1 = filled, color in 

RRGGBB hex) 
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        VXProcess.Runtime.DrawSphere(ref pos, 0.2f, 0, 0xffffff); 

    } 

} 

 

 

Appendix A: Data Flow from Unity to the Volumetric Display 
 

A overview of how data and interactions occur from Unity to the Volumetric Display.  

 

 A Unity scene that contains an active 
_camera prefab and some models or scripts 
that will interact with the volumetric display.   

 Unity x Voxon Plugin has a valid Voxon 
_camera prefab linked to it and a valid 
VxProcess script defined in its Process 
Manager. 

 The VxProcess manages a valid Voxon 
Runtime and _camera. 
 
It will start a new Voxon Application Window  
 
the VxProcess script will then enter its main 
update loop: check for a Voxon Runtime 
breath(), process all graphics and prepares 
the volumetric image while listening for 
system and user input. 
 
It sends the volumetric frame data to the 
volumetric display through its Runtime.cs 
class instance. 
  

 A class that resides inside the VxProcess 
script that allows the VxProcess script to 
interact with the Voxon Runtime.   
 
A local Wrapper or C# instance of the C# 
Voxon Runtime adheres to the 
IRuntimePromise. 
 
Requires C#-Runtime.dll to work.  

 The C# Runtime.dll converts the C# Voxon 
runtime calls into C++ so the native Voxon 
Runtime (voxiebox.dll) can be accessed 

VxProcess.cs Script 

(includes the Runtime.cs file type) 

C# Bridge Interface 

C# Runtime.dll 

Unity 

Unity x Voxon Plugin 

 

Runtime.cs 

Local instance to  interact with the 

C# Runtime 
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 The native Voxon Runtime receives the 
translated data and instructions and 
operates the Voxon Application as normal 
and sends data to the Volumetric Display 
 

 The Volumetric Display renders the Voxon 
frame data as a complete volume. 
 
 

 

Appendix B: Transforming Unity Space to Voxon Space 
 

The Voxon Runtime uses a different transform to what Unity and other popular 3D software 

uses here is how to translate between the two spaces. 

 

Unity Axis Voxon Axis 

X X 

Y -Z 

Z -Y 
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